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APPENDIX I     BUDGET 
 
PERSONNEL & LAB RENTAL  TOTAL: $6620 

$4200   class replacement for Kathleen Cohen  
$1500 payment as Associate Director of Conference: Dr. Roxanne Robbins 
$500  for rental of Mac lab at  Pomona and payment of staff: Cal Poly Pomona 
$140 Student Assistant Help, SJSU  
$280      Overtime for Stacy Meuller, VR Curator  SJSU 

 
FOOD AND LODGING  TOTAL: $3266.49 

$1027.95 To Hyatt St Claire for 10 rooms April 20, 2001  
$927.84 to Spartan Catering for dinner April 20, coffee and rolls and lunch April 21 
$527.15 to Kellog West Dining Catering: Dinner April 27; lunch April 28th.  
$121.39 to Los Olivos Catering for Coffee and rolls April 28th  
$662.16 lodging at Kellog West, Pomona for April 27th   

 
SUPPLIES & SOFTWARE: TOTAL: $2758.22 

$2412.95  to Scansoft for 25 upgrade copies of ImageAXS Pro 
$112.65  Duplication costs  
$232.62  CDs, Binders, etc.   

 
TRANSPORTATION & PARKING TOTAL:$285.00  
 
TOTAL Costs for DIGITAL Imaging Conference/Workshop  $12,929.71*  
(*Note: funds not used for the workshop are being used to pay student cataloguers working 
toward a repository of shared images.  
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APPENDIX II:  DIGITAL IMAGE WORKSHOP PARTICIPANTS 

 
Stanislaus Dr. Roxanne Robbins Art History Faculty 
San Jose Dr. Kathleen Cohen Art History Faculty 
San Jose Stacy Mueller Visual Resources Curator 
Fullerton Debra Winters Visual Resources Curator 
Fullerton Larry Johnson Studio Faculty 
Fullerton Dr.  Zena Pearlstone Art History Faculty 

Los Angeles Dr. Manuel Aguilar Art History Faculty 
Los Angeles Robert Evans Visual Resources Curator 

Pomona Therese Mahoney Visual Resources Curator 
Long Beach Loy Zimmerman Visual Resources Curator 

Northridge Alicia Escobar Visual Resources Curator 
San Diego Lilla Sweatt Visual Resources Curator 

Pomona Kathy Morgan Visual Resources Curator 
Dominguez Hills Dr. Noreen Larinde Art History Faculty 

Pomona Art Hacker Art History Faculty 
Fullerton Larry Peters Theater Arts Faculty 
Fullerton Nancy Fritch History Faculty 
Fullerton Patricia Young Education Faculty 
Fullerton Marilyn Rhode Art Ed Faculty 

San Bernardino Kurt Collins  Studio Art Faculty 
Fullerton Nancy Pelaez Biology Faculty 

Bakersfield Shelley Stone Art History Faculty 
Chico Dr. James McManus Art History Faculty 

Hayward Malka Helfman Visual Resources Curator 
Humboldt Catherine Clague Visual Resources Curator 
Humboldt Dr. Shiela Ross Art History Faculty 

Fresno Lynn Galloway Visual Resources Curator 
Fresno Gina Strumwasser Art History Faculty 

Sacramento Dr. Elaine OÕBrien Art History Faculty 
Sacramento Dr. Catherine Turrill Art History Faculty 

San Luis Obispo Dr. Keith Dills Art History Faculty 
San Luis Obispo Sheryl Frisch Visual Resources Curator 

San Jose Dr. Eveyln Bell Art History Faculty 
San Jose Dr. Patricia Sanders Art History Faculty 
San Jose Dr. Johanna Movassat Art History Faculty 
San Jose Dr. Marilyn Wyman Art History Faculty 
San Jose Dr. Arthur Kao Art History Faculty 
San Jose Dr. Beverly Grindstaff Art History Faculty 
Sonoma Karen Kessel Visual Resources Curator 
Sonoma Dr. Jennifer L. Shaw Art History Faculty 
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APPENDIX III   SUMMARY OF PRELIMINARY QUESTIONNAIRE 

FACULTY QUESTIONNAIRE FOR ITL DIGITAL WORKSHOP 
 
2. Do you teach the survey?  

Western A section_6   
Western  B section_10 
Non-western_4  
None_2 
Combined western & non-western/Asian;         World Art, actually___2 
 

3. Area of specialization? 
Medieval;  
Renaissance;  
17th-early 20th C 
20th c.;  
Ancient Near East and Islamic;  
Latin America and Europe; Asia, Modern European and American;  
Nonwestern;  
Greek and Roman;  
Modern; 
Modern and Contemporary, American, Theory and criticism  
Renaissance and Baroque;  
Asian Art History w/ minor in 20th C. Western; 
Italian Renaissance, but I am responsible for all of European art from Greek antiquity through 

the end of the 18th century (four different upper-division classes plus the two halves of the 
introductory survey of western art). 

 
1. How support staff do you have in art history (VR curator and/or student assistants)?      
None 
1 part-time curator; 4-5 student assistants  ( Poly,SLO) 
1 curator, 1 student assist. (San Diego) 
1 curator, misc assistants (Humbolt)  
Curator and student assistants (Chico) 
Great curator and student assistants (SJSU) 
We have an excellent VR curator and his assistant. (San Bernardino) 
What’s a VR curator ? 
1 slide librarian 
One curator, several students (Sonoma) 
We have a VR Curator and each art historian has some hours for student assistants.(Fresno) 
One student assistant . Generally we only have a part-time (7 hours per week) student assistant 

in the department’s slide collection, where there is no VR curator (therehasn’t been a 
staff position here for about a decade). The student assistant only works during the fall 
and spring semesters. This semester we snagged some extra money and were able to 
hire a former student at 30 hours per week.  The two full-time art historians share the 
management of the slide collection. (Sacramento) 

 
4. Rate your computer skills  on a scale of 1 to 10, with 1 being total novice and 10 being a 

real computer wonk.   
5, 5, 3/4, 5, 4, 10, 4, 2, 5, 4/5, 5/6, 5, 4,5,  
 
5. Do you do word processing on the computer?         Yes:  13 
 
6.Have you used a database program?  If so, which?     Mostly No 
Yes, Powerbase;  
Not unless Excel counts 
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I don't think so.  I don't really know what a database program is, in fact. 
 
7. Have you used image processing software like Photoshop? Yes:  6 
 
8. Have you presented digital images in class?        Yes:  7 
 
9. Do you communicate with your students by email? Yes:  13 
Yes, but only in a very specific and occasional way--responding to questions they might send 

electronically, for example, or sending them their final grades if they give me their e-mail 
address on the final exam or paper.  I always include my e-mail address on the class 
syllabus. Not all of my students have or use e-mail. 

 
10. Have you used a listserv?       Yes:  8 
No, not yet.  My predecessor as chair did set up a listserv of our majors (or tried) but used it 

infrequently and even then had to deal with all kinds of returned messages due to 
incorrect or expired addresses. 

 
11. Do you have a course web-site with review images?         Yes:  8 
Multiple sites; working on one now; Yes, for all classes; 
No.  It's not because I'm a Luddite.  I simply don't have the time or resources to put something 

like this together.  I still use slide-display cases and slide review sessions.  I also give my 
students the addresses of reliable art history websites so that they can look up images 
independently if they like, and if they have computers with home connections to the 
internet (not all of them do). 

 
12. Have you done any on-line projects with your students? Yes:  5 
Very limited; Yes, but not very extensive ones. 
 
13. Are you interested in participating in distance education? 
No: 5 
Yes: 2 
Somewhat: 1 
Maybe: 1 
Have done it.;  
Yes Have for 30 Years;  

I am very skeptical of this means of teaching, to be honest.  I really prefer sharing the 
same physical space with my students. 

Perhaps in the future! 
 
14. List below some of the things you would like to talk about at the Friday dinner. 
How others are using computer based resources for student learning.  
Databases for art historical research.  
Equipment and budgeting for additional equipment 
All ears 
Faculty education - TIME AND INDEPENDENT TUTORING 
Budget for visual resources 
I'd like to hear how others teach their large courses using digital imagery (if they do) and 

increasing student participation. 
Commercial CD's with Art History Images 
Teaching of Art History, Latin American Art 
How do we make art history applicable to our students in the early 21st century? Can current 

technology assist us in this challenge? How do we develop programs that will encourage 
innovative teaching and excite ourstudents? How do we find the time to become involved 
in this novel technology? 
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HISTORICAL experiences of faculty who have used digitized images in lieu of slides in the 
classroom: that is, how this means of teaching has worked over a period of more than 
two years.  How long do the images last?  How well does the technology hold up? How 
easy is it to keep up with changes? How much financial support does the university offer 
for keeping up with those changes?  How do the two systems--slides and digitized--
compare for quality of image in a large classroom, flexibility, etc. Is it advisable to make a 
complete switch over from slides to digitized images? (actually, I assume these topics 
won't be restricted to the supper table chat.  What would link anything with that venue, as 
opposed to the Saturday workshop?) 

 
15. What you hope to get from the workshop? 
A better understanding of how to use computer resources for teaching & research.  
A more facile retrievability using CIELO & better understanding of ImageAXS Pro. 
Knowledge of CIELO and how it works 
A better knowledge of how to use digital imagery in the classroom.  If you could teach me how to 

use Power Point in a short time, that would be great! 
Ways to better integrate the technology into teaching strategies that encourage the student to 

make direct contact with the works of art 
Meeting with colleagues and sharing ideas Information and stimulation!  I hope that this 

experience will promote my desire to become more involved technologically and lessen 
my fears! 

Tools to improve and support my teaching. 
Information about new technology that is practical 
Greater knowledge about the future. 
More expertise. 
Opportunity to see systems at work—both as a means of teaching (classroom image projection) 

and as a means of reviewing (images on the computer monitor in lieu of slide display 
cases, for example) 

 
16.  What you see as a next step for the CSU with digital imagery? 
Certainly more images and perhaps a collaboration w/ the UC system. 
We need to share resources more 
Develop an archive of video clips - architecture, performance pieces, installations, bio sketches,  
Making it more widely available to faculty across departments - sharing 
More digital imagery classes. 
Easiness and flexibility  
On-site, easy-to-use, reliable equipment to make it usable in the classroom. 
Obtain commercial disks, which are now readily available through CSU granting money for the 

purchase. 
Used extensively with proper training and equipment provided by CSU 
Proper equipment in every classroom—probably an impossibility for this century I would hope that 

the CSU retains and supports both digital and slide systems.  I am wary of the pressure 
being placed by administrators and media center supervisors on faculty to go with digital 
alone.  Unless the CSU is willing to FULLY support either system, with well-informed, 
fully-equipped and adequate media staff and service centers plus well-designed systems 
in the classrooms, we are going to be worse off than we are now.  Right now we faculty 
find ourselves constantly having to scramble and plead because something in the a.v. 
system is not functioning.  The more high-tech these "smart rooms" become, the more 
vulnerable we are, unless there is a corresponding increase in technical support.  The 
media center staff also needs to be sympathetic to the specific pedagogic needs of the 
teachers who use the equipment.  We should be the ones who decide what works best in 
our classrooms. One reason I like to stay with slides and slide projectors is that I can do a 
quick fix if a slide jams or a bulb blows.  What would I do if the computer crashed?  How 
can I wait half an hour, half a day, half a week for a tech person to stroll in or a substitute 
machine to be brought over? 
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Since I use a variety of media in my lectures, from works of art to newspaper images, to 
advertising and popular culture, as well as music and literature, I would look forward to 
the learning how to integrate these media into the traditional survey class. I know that this 
is possible, but the method, at this point, feels overwhelming! 

No clue whatsoever. 
 
17. Any thoughts on what you would like to see happen with digital art history in the 
classroom? 
Improved projection of images in the classroom context, more help (equipment & assistance-

people) from the Administration 
I hope it won't replace slides until the quality of images is higher and the projection equipment is 

more available in CSU classrooms. 
Frankly I worry that students are willing to accept the projected images of works as more 

authentic than a direct experience with the art object itself. How can this material serve 
as links, helping shape viewing experience and not substitute the experience? 

More dynamic classes and interactive relationship with the students.  It will also help to simplify 
our methodologies. 

A database that includes all the images we regularly use and more. 
I am curious to see if digital art history really is an improvement upon slide art history.  That is, 

are digital images superior to slides (better color, sharper quality, more durable, cheaper, 
etc.)?   I'm willing to wait and see on this one. 

High quality, easily accessible image sets that allow me to spontaneously choose images to 
project in addition to projecting them in an order that is set before the lecture. 

 
CURATORS RESPONSES TO QUESTIONAIRE FOR DIGITAL WORKSHOP 

 
1. Does your campus teach the AH survey? 

Western A section___8 
Western  B section___8 
Non-western__4  
None__ 

 
2.Are you full time or part time?      

Full  time:  ____6 
Full Time Temporary 
Part time:  (25%) 

 Part-time-20hrs/week 
 
3. What sort of support do you have in terms of assistants?        
One workstudy student 10-15  hours per week;  
1 work study 6hrs per week  
one half-time 
one 
10 hours per week 
10 hours per week 
4 student workers paid by work study grants. They work an average of 22 hours a week total. 
8 hours student help plus occasional grant-funded assistants for c20 hours/week. 
 
4. Rate your computer skills  on a scale of 1 to 10, with 1 being total novice and 10 being a 
real computer wonk.   

7.2, 8, 4, 4, 8, 8, 3, 9, 5,  
 
5.Do you do word processing on the computer?       Yes  9 
 
6. Have you used a database program?__Yes  6  

If so, which?     



Appendices: ITL Digital Image Workshop Report  7 8/23/01 

Hypercard, Image AXS Pro. familiarity and instructional use of EmbARK 
Filemaker Pro 5.0;  
Filemaker Pro;  
File Maker,  
Embark;  
Image AXS Pro, Filemaker Pro, Portfolio (administered through the library); 

 
7.Are you doing any digital cataloging?       Yes  3 

If so, which program do you use?     
Image AXS Pro; Embark;  
ImagAxs and Photoshop 
The one set up by CIELO, now used for Portfolio 

 
8. Roughly how many fields do you use?__8,  30, 20, 30 
 
9. Approximately how many images have you cataloged?     

5000 or more  (existing in various AXS collections) 
c. 5000 
c. 6000 

Since the instruction we have done is in Macromedia 
Director and the images acquired at low/non-archival resolution by a faculty 
member we haven't done any digital image cataloging.  We are still doing 
substantial collection development in our slide collection. 
 
10. Are you using the VRA Core for cataloging?    

Yes;  In part;  Adopted version; Mostly;  
For slides I use a Marc configuration with some fields similar to VRA Core but with some 

more added entry fields for subject searching. 
Yes (CIELO is based on it.) 

 
11. Have you used image processing software like Photoshop? Yes  6 
A little,  mostly the students do the Photoshopping. 
 
12. Do you create course web-sites with review images? Yes  3 
 
13.Has  your faculty presented digital images in class?    Yes  5 

Macromedia Director 
Two internet courses, African and Japanese 
 

14. List below some of the things you would like to talk about at the Friday dinner. 
What my duties would be as a curator of a digital collection 
How other campuses plan to use CIELO and where we might go with it in the future (e.g., 

expanding what we have, including the 2d half of the western survey, etc.) 
Further collaborative efforts in developing and sharing a digital image collection among the CSU 

campuses (or even with the UC system or possibly collaborative efforts in a national 
database of digital images).  I don't even think we have scratched the surface in getting 
really top quality copyright free images from educators in the state of California.  Also, the 
state junior college system should be welcomed to the use of our images.  This could 
bring many new images and new sources of funding and additional grants. 

Definitely an extension of CIELO into the Renaissance through modern eras. 
Self-sufficiency of faculty members in creating digital classroom presentations and web pages of 

images for their students. 
What kind of inhouse instruction and support do the faculty feel will be effective to get them to use 

digital images and webpage study pages. 
I am mostly interested in listening to what the faculty that present digital images in class have to 

say about the pros and cons. 
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A systemwide subscription to extensive digital visual images. 
 
 15. What you hope to get from the workshop? 
Personally, I hope to see my own faculty representative become self-sufficient in using AXS Pro 

& have a good introduction to CIELO.   I have conducted several small group instructional 
sessions in AXS Pro & will be observing your instructional methods to see if I've missed 
anything or could organize or emphasize anything differently. 

Skill in integrating CIELO into the needs of faculty.  I, also, am very interested in what other 
faculty are interested in so that I can suggest options to my faculty and be prepared for 
any of their future requests. 

I hope to get encouragement from the participants that collaborative efforts will continue in 
developing and expanding CIELO. 

Also, I hope to get the newest  PC copy of AXS Pro @ workshop so I can put images on faculty 
members computers & have them do their own work. 

A better sense of where faculty are in terms of willingness to use digital images and what it will 
take to teach them.  Also a method of presenting the CIELO project to non-art faculty. 

I hope to learn more about ImageASX Pro and Powerpoint. 
Up to date information CIELO and how faculty can use it in their classes. 
I am sure that whatever knowledge you pass on, it will not only be fairly new to me but it will 

enable me to understand various updated ways of cataloging.  Hopefully, it will help me in 
the future, if not in a job then in developing my own cataloging system if I teach at the 
Community College level. 

More info on image size and resolution, CD burning, comparing two images in digital 
environment. 

More about copy rights issues. 
 
16.  What you see as a next step for the CSU with digital imagery? 
Hopefully, as a future step, combining resources with other non-CSU institutions to build a bigger, 

better database of digital images. 
Filing in the CIELO gaps for the 201 survey. Particularly getting licensing for images we may not 

be able to obtain and in particular locating licensing sites for in-copyright art objects. 
The second half of the survey class. 
Coordinated subscription to digital visual images, the coordination of equipment and information. 
Video/Audio streaming in combination with slide presentation over the web. 
The curators are planning on starting to subject catalog the current CIELO images this summer 

and to possibly start working on the 2d half of the survey. 
 
17. Any thoughts on what you would like to see happen with digital art history in the 
classroom? 
Within 5 years I anticipate we at CSLA will be teaching almost 75% of our art history courses 

digitally in the classroom.  I would like to see the best digital images available and the 
widest selection possible for the students in the classroom.  Also, the ability of students to 
access those images shown in the classroom immediately on the web with full 
information and with possible links to other web sites for even further education. 

I would like to see if we could get another presentation software program such as the Luna 
Insight for the system or the new competing one out of Michigan I think which is a 
combination image database and presentation system. 

If a professor could program the digital images for their lecture and present their images from a 
built-in computer system that would be perfect. 

I think we need to get more faculty to buy into the whole process.   Would also like to see more 
support for the whole process as far as budget goes. 

I hope that it can be flexible enough that professors do not get set into a route organization of the 
survey courses, but instead are challenged to look for new artists and information, 
constantly updating their CD's.  I would like to see websites where images can be taken 
for use on CD's.  But i want to see images that go beyond, Frederick Harte or the Jansen 
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books which do not include many women artists or artists of under-represented cultures 
and races. 

I would like more instructors to use digital images for presentation. Also digitize the whole 
process from digital video camera to scanners to the web, CD Rom and DVD.  

Some easier way to deal with copyright would certainly sped up our move to digital images in the 
classroom. 
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APPENDIX IV  SUMMARY OF FINAL EVALUATION 
 

1. Name & Campus(optional):      

Campus (optional): San Luis ; Chico; Humbolt,, Hayward,  Pomona, Fresno. Bakersfield, Fullerton, 

San Diego, Sacramento, Dominguez Hills, San Jose State,  

2. What is your area of specialization?   
19th and 20th century Painting and Sculpture;  
Renaissance; European;  Classical; 
17th-early 20th, especially 19th C European 
Asia & Modern  
Architecture: history, theory & Design modern art history 
Renaissance and Baroque 
Native American 
Studio Art  
Elementary Ed: 2 
Biological Science 
History 
Curator / Art Slide Library:6 
 

3. Which computer  platform do you use? 
               Mac:18        PC:9 

4. Which program did you practice in the workshop? 
      ImageAXS : 21 Powerpoint:13 

5. Do you teach the first half of the Art History survey course? 
Yes:5         No: 6  NA: remainder 

If so, which text do you use? 

Stockstad:3   Gardner:1 Traktenburg & Koslof:1 

6.Do you teach the second half of the Art History survey course?   
Yes:6   No:7  NA: remainder1 

If so, which text do you use? 

Stockstad:4 Gardner:3 Janson:2  Traktenburg & Koslof:1 

7. Rated on a scale of 1 to 5 to what degree would you feel confident presenting digital images in 
the classroom (1 is most confident, 5 is least confident) 

       2,2,1,3, 5, 5, 3, 4, 5 3,1,2,2,1,5,3,31,2, 

8. Do you plan to use digital images in your class room? 
Yes: 17   No: 2       NA: remainder 

I eventually hope to use digital images. 

Not for the moment. 

9.  Do you plan to use the CIELO CD in your classroom?                                
Yes: 13  No:3         Don't Know: 11 

Not at the present because it does not include the material I teach  

Yes, if developed for the second part of the survey!  

Not for the moment. 
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10.  If a specialized CD were developed for your area would you use it?    
Yes: 12 (Ren, Asian   No:         Don’t:Know:2   
Possibly  (Mod) 
Not right now (Ancient) 
Not in the classroom. However, I might recommend it as a supplement to the text. 

11.  To what degree did the workshop meet your expectations? (1=most   5=least) 
 1,2,1,2,2,2,3,2,1,1,1,1,1,1,1,2,1,1,2  

12. How useful did you find the following activities (1=most   5=least) 
Friday evening  theoretical discussion: 2,3,1,2,1,4,3,3,3,1,2,3,2,1, 

Saturday hands on workshops:   1,1,1,2,2,1,1,2,2,1,1,1,1,2,1,1,1,1,1,2  

What did you find most useful? 
Practicing ImageAXS and connecting with interesting people 
Powerpoint & ImageAXS Pro instruction 
Powerpoint info 
Hands-on 
Everything! 
Theoretical discussion 
Q&As and the hands-on: seeing it done and then doing it was extremely useful. Questions and 

answers also very helpful. 
Learning ImageAXS Pro. Meeting and interacting with faculty and curators from different 

campuses. 
Repetition of the Process 
ImageAXS database will solve many of the problems we encounter handling images in biology. 

We will benefit from this model developed by the Art History experts. 
The actual “hands-on,”  PLUS communications – in general – with my colleagues at other 

campuses! 
Working with my faculty member and having someone knowledgeable at hand to answer our 

questions 
Working with ImageAXS 
Presentation and discussion. 
Watching demonstrations and hearing discussion of issues related to teaching with digital 

images in the classroom 
Working with the software. 
It was exciting the meet the presenters and colleagues from other CSU campuses to discuss 

which instructors are employing the new imagery. The hands on session, however, on 
Saturday, was equally valuable because I had not had that experience before. 

Experience using the images. 
Most useful of all was a collateral part of the workshop: exchanging information and ideas with 

other CSU art history faculty. 
The hands-on work with the programs. 
The hands-on workshop. 

 
How could we most improve? 

Great as it was. 
Perhaps more time. 
Software loaded in advance.  More IBM expertise, perhaps…(brought his own PC). 
Talk more about production issues (CD production, WEB etc.) 
I thought the workshop was really well planned.  I wouldn't change a thing. No, sorry.  I'd get the 

heat turned on in the Art Building for the Saturday sessions! 
Talk about linking ImageAXS and web. 
I would like to have a general discussion in which each person briefly describes how they are 

using digital imagery for teaching.  I think we could learn a lot from each other.  Some of 
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this happened in informal discussion, but there was not enough time to talk to everyone 
about this. 

Continue to see these workshops as interdisciplinary. 
Open more workshops to cross-disciplinary groups. 
Very helpful.  
Maybe some of the suggestions, such as sharing spreadsheets for slide data, could be resolved 

into formal resolutions or some follow-up plan of action agreed upon. 
It would be helpful to have two mornings with which to work with the digital equipment. There was 

much information to address and it would have been nice to have it absorbed and then to 
apply  it again the next morning. But, keep in mind, that I, unlike most of my CSU 
colleagues, had not had any experience before this conference. Most importantly,  the 
experience (and Professor's Cohen's enthusiasm and knowledge) stimulated me to re-
think our options at CSUF and to consider delving further into employing digital tech. 

More time. Maybe smaller groups covering specific topics. I can't afford projection equipment 
right now, so websites are what interest me. I need to know how to set one up, etc. 

I would have liked to see how projection of the images worked in a larger facility and under 
circumstances closer to those in an actual class situation (i.e., two images side by side).  
Actually, it would have been helpful to sit in on an actual art history class taught by 
someone who uses either of the systems demonstrated to us. 

I would like to see you get someone on board that is more IBM proficient so things go a lite more 
smoothly.  That way you could concentrate more on working with various aspects of 
ImageAXS. Perhaps more hands-on time. 

 
15.  Indicate your interest in follow-up workshops in the following areas (1=most 5=least) 

Editing images in Photoshop:  3,1,1,1,1,1,1,5,3,2,1,1,1,1,1,5,2,3, 

Additional work with Powerpoint:   5,3,5,5,3,5,1,1,2,2,3,1,4,3,5,4,3 

Additional work with ImageAXS Pro:  1,2,1,1,3,1,1,3,2,1,3,1,2,3,1,2,1,2, 

Finding & Using Web Resources: 3,1,5,1,3,5,2,3,1,2,2,1,1,1,1,3,3,2, 

Creating Web pages:   1,1,2,1,1,1,2,1,1,1,2,1,1,1,1,2,1,3,1 

16. What workshop format would you prefer? 
Friday all day: 6 
 
Friday Evening, Saturday all  day: 11 

Saturday all day: 7 

 Saturday all day & Sunday 1/2 day: 1 

 Other: Friday afternoon and Saturday morning: 1 

17. If a workshop were held on your campus how many others do you think might be interested in 
attending?   

  Yes, but only three or four people… from this campus (Cal Poly, San Luis) 
At least 10-12 whom I could name right off. (Chico) 
yes! (Humbolt)  
12 to 15 people. (Hayward) 
Perhaps 10-12 (San Diego) 
Many (Pomona) 
There would be several artists in the department who  might want to attend. (Fresno) 
Only a couple. (Bakersfield) 
Possibly as many as 10 art and art history faculty.  Other faculty from the Departments of Design, 
History, 
Humanities, and the Women Studies programall of whom teach with slides occasionally also 
might be interested.  Try 15-20 as an audience? (Sacramento) 
3-4 (Pomona) 
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20, 2, 10-20, 20,0 Don’t know, Quite a few (Fullerton)  
3 ? 
Would require a poll of humanities, history & anthro (Dominguez Hills) 
 

 18. Does your campus offer workshops Powerpoint and/or Excel? 
   Yes: 17  Not sure: 2  No:1 

I will be participating in a week-long workshop the first week of June and will see from there what 
is being offered. 

 
Does your campus have a technology "help desk" or persons who are assigned to 
specifically help the faculty with technology questions (both hard and software)? 
Yes: 18  
Yes, but only on supported software 
Yes, but unfortunately it could take some time (hours or days) before we 
receive help. 
Service is spotty. 
Mostly PC 
Don’t know 
Yes but it is not always helpful 
 

19. How important do you think the following activities would be for the future?  
More training in creating digital presentations 

 1, 2,1, 1, 1, 2, 1,1,2,1,1,2,1,2,3,1,2,2,2,1,2,1  

Equipment for digital presentations in the classroom      
Second Highest  priority, 1, 1, 1, 1, 1, 1, 1,2, 1,1,3,1,1,1,1,1,1,2 

Development of image collection for 2nd half of survey     
Third Highest Priority, 1, 2, 3, 1,2, 1, 1,1, 1,1,3,1,1,1,1,1,1,5,1,1,2,2,1 

Licensing images we don’t have (AMICO, Saskia, etc)    
Highest Priority, 1,1,1, 1, 1, 2, 4, 1, 1,1,2,1,1,1,1,1,3,3,1,1,3? 
 
Sharing data between campuses via excel spreadsheets    
High priority, but not top three, 1,1, 1, 1, 1,1, 1,3,1,2,2,1,2,1,1,3,3,1,1,3,5  

(I'm not sure what that means!!) 

Procuring additional technical help on campuses  
   1, 1,11, 1, 1, 2, 1,1,3,3, 1,1,3,1,5,2,1,1,3,, 

Establishing a central CSU image databank  
1, 1,1, 1, 1, 1, 1, 1,1,1,2,1,1,1,1,1,1,1,1,13,1 

Additional suggestion: Creating CDs 

20. Which would you say is most important? 
More smart rooms for lectures; licensing arrangements for images [Amico $$ support], 

Development of second half of survey;…    improved communication amongst the 
campuses, probably through a central ‘clearing house campus’ [SJSU??] 

Sharing data between campuses via excel spreadsheets 
All of the above are necessary if we, as a system, are to move into the digital age. 
Establishing a central CSU image databank:111111 
Technical help for slide librarians/professors—to help with course webpages, scanning of 

digital images etc.  Having a very high quality image bank for the campuses. 
For me it would be more useful to talk to my slide curator. Driving and spending 1-2 days 

uses up too much time. 
Equipment for digital presentations in the classroom 
Selfishly, I need far more training.  After that, perhaps it would be possible to respond more fairly. 
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For me, getting equipment and images. We are seriously under funded, so at the moment I am 
interested mainly in presenting images on a website. 

Improved and expanded image databank that can be shared by CSU campuses, plus adequate 
tech support so that it can be used well. 

Develop images in my area of specialization (Native American) 
Procuring more technical help 
For me equipment 
Second half of the survey, even though I teach the second half of a world history survey. 

 
21. What other issues should we consider? 

More staff for visual resources collection. 
We need help in acquiring quality images. 
Incorporating images into the curriculum. 
Establishing procedures for creating and developing digital presentations to be shared and 

followed by all campuses. 
Some hours devoted to financial solicitation for equipment and home campus assistance 

(meaning training as well as technical support for equipment and classroom assistance). 
What we can make available to our students to take away with them. 
Sharing & collaborative projects 
What can we make available to our students 
Who uses what images for what purposes  
Knowledge needed for cataloging cross-disciplinary collections.  

 
Additional Comments:  
Thanks for the great workshop.  I learned a lot. 

I can't believe how much I learned in a day + access to the fabulous images! One of, if not the best 
workshop of this type. Extremely worthwhile. I am not an art historian, but an historian who 
teaches world civilization. I have taken quite a few computer classes related to my interest in 
development multimedia materials for my world history class. This was by far the best class I've 
taken. I learned how to use two programs what will help a lot, which is amazing for a one day 
workshop, especially given the complexity of one of the programs.  I also found the pedagogical 
suggestions for using the material extremely interesting and ideas for how I can teach with 
multimedia better than I have to date.  Altogether a worthwhile experience. Thank you so much 
for allowing  others than art historians in this workshop. I also appreciate having access to these 
fabulous images with the information on them for use in my classes. --Nancy Fitch, Fullerton. 

 
I thank you for organizing this excellent workshop. 

Thank you for a very well informed and organized workshop. I was happy to see you and all the 
other participants, and I appreciate your efforts and knowledge in the subject. 
 
Thank you so much for all of your time, effort, expertise and patience this weekend.  I can imagine all the 

work you put into the seminar that included organizing and catering in many ways. You are a 
dynamic person and Lynn and I felt quite inspired returning to Fresno on Saturday afternoon and 
talking about the experience. I only hope that we did not cause you too much "pain". The meals 
were great and we so appreciated your special care with all the details.-Gina Strumwasser, 
Fresno 

 
I've been meaning to send you a big Thank You all week for the great workshop last weekend.  It was 

very useful to work with the faculty and to see at what different levels they were in using digital 
images.  None of us would be as far along with our databases without your longtime dedication to 
digital images and your generosity in providing your own images for the CSU system. 

 
And the hotel was Wonderful!  I'd like to come to San Jose more often and stay there.  I had to give up my 

last 2 performances (Fri. night & Sat. matinee) of the SF Ballet rep season for the workshop.  It 
was worth it! 
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A little feedback on what your workshop has started here at Fullerton. 
I. CSUF  Cross-displinary Digital Image Instruction Committee (CDIIC).  Task 
to develop digital images for CSUF instruction. 
*       Study how faculty from mutliple displines use images in their 
classrooms 
*       Determine what kind of digital images are needed 
*       Set standards for cataloging 
*       Seek funding to develop projects 
Tentative committee members Debra Winters, Marilyn Rhode, Nancy Pelaez 
(Biology), Patricia Young (Elementary Education), and Nancy Fitch (History). 
 
II. Instructional Development Grant with Nancy Pelaez from the Biology Department to develop a science 

database for teachers that will contain digital video clips to be used in K-8 science instruction.  
Copyright releases, database design and cataloging will be expertise added by Art Department 
Visual Resources Specialist. 

--Debra Winders, Fullerton 

Thank you SO MUCH for the informative workshop!  We will benefit in Biology from the progress made in 
developing a quality Art History database to store and share digital images.  As I explore the 
CDRom provided and the database software, I realize that we still have much to learn from the 
hard work of the arts and curator experts! --Nancy Pelaez, Fullerton 

 
I look forward to future workshops - perhaps on topics such as (1) creation of digital image CDRom's for 

student use, (2) web design for dissemination of collections, and (3) optimization of collection 
designs. 

I can foresee a new project growing from the CIELO project: VIDA (video and image data access) Survey 
of social and life sciences for K-8 teachers. 

 
The database works well with MPG video clips we use to analyze biological and pedagogical data.  I 

might start with my video clips of Belize jungle animals and my colleagues have video clips 
showing fish locomotion and electron microscopy images of cells.  I will contact the American 
Physiological Society to ask if they will grant permission or if they would otherwise like to join us 
in making their published journal images available for prospective K-12 teachers. Very productive!  
THANKS! 

 
22. Would you be interested in participating in an all CSU Discipline Council for Art History? 
 Yes:11  No:1   No Response: others   
 

Would you be willing to assume a leadership role? 
Yes:1  No:11 
I normally would be interested, but I have so much to do right now…. And am really “at the end” 

of my career, almost….    But… I’m planning to ‘work harder,’ and to follow the example 
of Dr.  Cohen at SJSU! 

No, but only because I don’t have the time (see #20.) 
Possibly; perhaps; possibly 
Not in the near future because I have very young children, but maybe further down the road/ 
Maybe, depending on what this is for and what issues would be addressed 
Just what did you have in mind? 
 

SURVEY OF AVAILABLE RESOURCES 
23. Do you have images that you have taken of art works that are ordinarily covered in art history 

survey or specialty courses that you would be willing to share for the creation of a CD/and 
website of the 2nd half of the survey or  for specialty courses ?  

    
Yes: 11111111111         No:1111    No answer: remainder 
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Yes I have a few but not many. I have lost three cameras in Europe and have traveled often 
without one! The images that I have, originally in printed photographs and then made into slides 
are not digitized. 
 
Are your images labeled or otherwise identified?  
Yes:1111111  No:1 Not always, sort of 

Yes, some, but I can identify them all;   . Somewhat!    Some       

Approximately how many do you have?  
     1-50:1   52-200:1111  501—1000:111 More than 1000:11  Unsure 
 

Approximately what percentage are architecture or other outside shots?   
50%, 90%, almost all, 70%, 85%, 100%, 95%most, 50% 95% 50% 

Approximately what percentage are painting or other museum   shots?     
50%, less than 1%, very few, 30% mostly sculpture, 15%, 0%, 5%50% 50% 5% not usable 

What geographical area or historical period is the focus of your collection?    
European museums, California Architecture. 
Architecture, European (England, Italy) and USA 
Italy/Greece (mainly ancient), U. S. (modern architecture) 
Mediterranean. Greece and Italy. Also have some museum  shots from  the Louvre, British 
Museum and Vatican. (ancient) 
Italy: antiquity, Middle Ages, Renaissance, Baroque (Sacramento) 
Native American, Mexico 
Japan, Italy, California 
Asia & Europe  
Italian Renaissance, 19th-20th century 
France & Brazil 
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APPENDIX V    SELECTED WORKSHOP HANDOUTS 
 

Taught two programs at the workshops: ImageAXS and Powerpoint. We include the handouts for 
ImageAXS since they are in digital format. The Powerpoint handouts are available in xeroxed 
format from Roxanne Robbin.  

 
USING THE MAC VERSION OF IMAGEAXS WITH THE CIELO CD. 

 
BEFORE YOU START: 
The computer monitor should be set for millions or thousands of colors with a resolution of 
approximately 800 X 600 or 1028 X 764, depending on the size of your monitor. If no images show 
up, be sure that Quicktime is installed in your system folder, for it is necessary to show them..   
 
Open the CD by double clicking on the Jaz 1GB icon. You will see a number of file folders.  
The Read_Only_collections run with the ImageAXS-CD program that is included on the CD. the 
AXS_Pro collections need ImageAXS Pro to run. It is provided on a separate CD. The big_img 
folder contains the images that all the collections will access.  
 
Use the Help menu to turn Balloon Help ON, and run your mouse over the various icons to see 
what they mean. Follow the directions below, and use the ImageAXS Help menu later to find out 
more about the program.  
 
VIEWING THE COLLECTIONS 
First open theImageAXS-CD application located in the ImageAXS-CD folder. Choose Open from 
the File Menu and select one of the  files from the Read_Only_Collections. When the collection 
opens you will see a series of thumbnail images. To view individual images and their text click the 
INFO button. If you have just opened the program, clicking on the Info button will  select all  the 
images and you can move through them as noted below.  
 
NOTE: If you want to enlarge the entire window, click the box in the upper right corner, which will  
enlarge the window to the size of your screen. Clicking it again will  make it smaller. 
 
The upper part of the screen has a series of fields containing the cataloging information. Below 
them is a longer field that can contain freeform text. 
 
NOTE: If the text in one of the boxes of the upper section is too long to fit within its field you may 
scroll to the end of it by pressing on the right arrow. Very few images are accompanied by long 
text, but they are one can read the text in the large description field by using the slider bar at  the 
right hand side of the text window. Press on the down arrow  to scroll through the text. If the small 
box is not at the top of the slider bar, drag it to the top by holding down your mouse button while 
you move the mouse.  
 
MOVING THROUGH THE SCREENS 
Move through the information screens by clicking on the right arrow ( the > symbol) in the 
ImageAXS menu. You can move back by clicking the left arrow symbol (<), to the end by clicking 
the >| symbol. Experiment a bit until you are comfortable.  
 
Click the close button in the upper left to go back to the thumbnail screen. From there you may 
select individual images by clicking on them. 
 
SELECTING AND ENLARGING IMAGES: 
To select a group of images, hold down the Apple command key while clicking on the images. 
Those you have selected will be enclosed in a red square.  
Note: To select all the images press the "A" and Apple keys at the same time.   
To deselect them press the "0" and Apple keys at the same time 
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You can enlarge an image by double clicking on it, either in the Thumbnail view or the Info view. 
In order to enlarge an image, double click it with  the mouse. When you move the mouse into the 
picture the cursor will change from an arrow  to a magnifying glass with a " +" sign in the center. 
Click the mouse until the ratio printed in the center of the window bar changes to 1:1, which 
means that you have a full sized image.  You can reduce the size of the image by clicking on the 
“-“ sign in the lower bar. 
 
Note:  You can increase the size of the window by dragging on the box in the lower right. If the 
entire image is not displayed, you can navigate around it by using the slider bars.  
 
Close the image window  by clicking on the close box on the upper left.  
 
SEARCHING  
Click the SEARCH button on the upper left of the screen. When the Search screen appears click 
TITLE under FIELDS and CONTAINS under COMPARATORS. Type the word or words you are 
looking for under VALUE and then click the SEARCH BUTTON. (Try searching for a word that 
appears in several of the titles.)  
 
SHOWING IMAGES IN CLASS & MAKING A SLIDE SHOW 
You can show images in two ways, either one at a time by clicking on the thumbnail image, which 
will make it larger. (Click again until you get a 1:1 ratio, which will show on the top frame.) or you 
may create a Slide Show which will show your selected images at a size that is as large as the 
monitor is capable of showing. 
 
To show up to four images simultaneously. Open the images you wish to display together by 
double clicking them. Then select either Tile Front two, Tile Front Three, Tile Front Four from the 
Windows menu. (Tip. Holding the Apple and  9 keys simultaneously will display all that you have 
opened.) You can move the windows around and make individual images larger or smaller.  
 
To make a slide show, first tell the computer how you would like display the images by going to 
Preferences on the Edit menu, then pick Slide Show. Your slide show can be automatic (set time 
interval) or controlled by you (select Manual). You can show your images in a window or use the 
full screen. If you are using ImageAXS-Pro you can chose to have captions presented. Select the 
images that you wish to show either by selecting them all  (Select all  from the Edit Menu) or 
selecting them one at a time by clicking and holding down the Apple key on the Mac and the 
Control key on the PC.  
 
To show your slide show select Slide Show from the View Menu. If you selected Automatic, the 
show will  play through, but if you selected Manual, you can control the length of time the image 
shows by clicking on the forward (>)  or back(<)  buttons at the lower right of the screen. You can 
stop the show by clicking on the close button.   
 
QUITTING 
To close the lesson either click on the close button in the upper left of the collection screen  or 
select CLOSE  COLLECTION from the FILE menu. Selecting EXIT will close the ImageAXS 
program.  
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DIRECTIONS FOR USING THE WINDOWS VERSION OF IMAGEAXS 
 

BEFORE YOU BEGIN 
Set your screen to Thousands of Colors. If it is set for 256 colors the images will look grainy. 
TECHNICAL NOTE:  The images are captured in 24 bit color at approximately 825 X 1100 pixel 
resolution. The computer monitor should be set for millions or thousands of colors with a resolution of 
approximately 800 X 600. 
 
In order to view the collections you will  have to install the ImageAXS-CD application onto your 
system. This needs to be done only once. Navigate from My Computer to The CIELO CD. Open 
the Program folder. Double click on the IMAGEAXS EXEC file.  Follow the on-screen directions 
to install ImageAXS-CD on your computer.  
 
Navigate  from the Start button to Programs, to Accessories. Open Wordpad. Select OPEN  
from the FILE menu. Navigate to the CIELO CD & select 1ST_READ. Print the file, which gives a 
content list and detailed directions for using the program. 
 
VIEWING THE LESSONS 
*Start the program by selecting ImageAXS CD from the Program menu.  Select Open Collection 
from the File menu  and  navigate to the CD. Double click on the lesson you wish to view (see list of 
lessons for names of files). It will take some time initially for the program  to load from the CD, but the 
lessons themselves will load fairly quickly. You will see an information screen  while the program is 
loading, followed by a series of squares, which will gradually fill with thumbnail images.  Be patient. 
 
NOTE: Enlarge the window by clicking the window icon on the title bar in the upper right between the 
minimize and close icons.  This will  enlarge the window to the size of your screen and allow you to 
see more thumbnails. Clicking it again will  reduce the size of the window. 
 
* Across the top and down the left side of the screen are menu  bars. As you pass your mouse over 
the icons on the menu bars, their functions will be explained in small pop-up boxes.   
 
*To view individual images and their text click the Info button on the left side.  If you have just opened 
the program, clicking on the INFO button will  select all the images and you can move through them 
as described below.  
 
* You can read the text in the large field by using the slider bar at the right hand side of the text 
window. Press on the down arrow  to scroll through the text. If the bar is not at the top, drag it to the 
top by holding down the left button while you move the mouse. This is known as dragging.   
 
NOTE: If the text in one of the boxes of the upper section is too long to fit within its field you may 
scroll to the end of it by pressing the right arrow on your keyboard. 
 
MOVING THROUGH THE SCREENS 
* Move through the information screens by clicking on the right arrow ( the > symbol) in the 
ImageAXS menu. You can move back by clicking the left arrow symbol (<), to the end by clicking the 
>| symbol. Experiment a bit until you are comfortable.  
 
* Click the thumbnail icon in the upper left to go back to the thumbnail screen. From there you may 
select individual images by clicking on them.  
 
SELECTING AND ENLARGING IMAGES: 
* To select a group of images, hold down the Ctrl key while clicking on the images. Those you have 
selected will be enclosed in a red square. To select all the images press the "A" and Ctrl keys at the 
same time.  To deselect an image click it again while holding the Ctrl key. To deselect them all  press 
the Esc key.  
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* You can enlarge an image by double clicking on it in either the Thumbnail or Info views. When you 
move the mouse into the picture the cursor will change from an arrow  to a magnifying glass with a " 
+" sign in the center. If the image starts to fall apart or pixelate, you have gone too far. 
 
* You can reduce the size of the image by holding down the Ctrl key while you click or by selecting 
the Zoom Out icon on the left menu bar. Close the image window  by clicking on the close box 
indicated by an X on the upper right menu bar.  
 
* You can increase the size of the window by dragging on the box in the lower right or by clicking the 
window icon on the upper right bar. If the entire image is not displayed, you can navigate around it by 
using the slider bars or the Scroll tool on the left menu bar.  
 
Note: If you open a number of lessons in sequence, the lesson screen may slip lower  and to the  
right. Drag it to its original position by clicking on the upper title bar and holding the mouse down 
while you move up and to the left.   
 
SEARCHING  
* Click the Search button on the left menu. When the Search screen appears select Description under 
Field and Contains under Operation. Type the word or words you are looking for under Value and 
then click the Search button. Drag on the small arrows  beside FIELD and OPERATION to see the 
choices open to you. Clicking the Advanced button allows you do more complicated searches. Click 
the All button on the upper menu bar to return to the lesson. 
 
SHOWING IMAGES IN CLASS 
You can show images, either one at a time by clicking on the thumbnail image, which will make it 
larger. (Click again until you get a 1:1 ratio, which will show on the top frame,) you can show up to 
four images simultaneously, or you may create a Slide Show which will show your selected 
images at a size that is as large as the monitor is capable of showing. 
 
Viewing Multiple Images 
*To show up to four images simultaneously, open the images you wish to display together by 
double clicking them. Then select either Tile Vertically or Tile Horizontally  from the Window 
menu. You can move the windows around and make individual images larger or smaller.  

 
Making A Slide Show 
*To make a slide show, first tell the computer how you would like display the images by going to 
Preferences on the Edit menu, then pick Slide Show. Your slide show can be automatic (set time 
interval) or controlled by you (select Manual). You can show your images in a window or use the 
full screen. If you are using ImageAXS-Pro you can chose to have captions presented. Select the 
images that you wish to show either by selecting them all  (Select all  from the Edit Menu) or 
selecting them one at a time by clicking and holding down the Apple key on the Mac and the 
Control key on the PC.) * You can Select the SLIDE SHOW  option from the VIEW menu. The 
slide show will  scroll through the images that you select by enlarging them to fit the size of your 
screen. The show will cycle automatically or you can control it by using the SLIDER CONTROL 
menu. 
 
QUITTING 
*To close the lesson either click on the X close button in the upper right or select CLOSE  
COLLECTION from the FILE menu. Selecting EXIT will close the ImageAXS program.  

 
USING IMAGEAXS-PRO WITH A CD 

 
The CD has two sets of collections: the Read_Only_Collections that run with the ImageAXS-CD 
program included on the CD ,  and the AXS_Pro set that needs ImageAXS Pro to run, which is 
provided as a separate program. The big_img folder contains the images that both sets of 
collections will access. If you want to utilize the advanced features of ImageAXS-Pro like creating 
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Portfolios for lectures and dragging and dropping images into the order you want, you will have to 
copy the collections, but not the large images to something other than the CD.  
 
You will be able to access the large images that are on the CD when you use ImageAxs 
Pro, but you will have to put the collections themselves on either on a zip drive or in a 
folder on the hard-drive.!! Note: This is a pain, but if you don’t copy the collections to a zip or 
harddrive and try to work totally off the CD the program will crash. So follow the directions below. 
You will soon be able to use images from other CDs and other sources as well, and incorporate 
them into you presentations in the order you want to show them.  
 
*To  become familiar with the general features of ImageAXS follow the directions for using the 
version of ImageAXS that came on the CD before you use ImageAXS Pro.  
 
CREATING COLLECTIONS FOR USE WITH IMAGEAXS-PRO 
 
Open the CIELO CD by clicking on the Jaz 1GB icon. Drag the AXS_Pro Collections folder to the 
hard-drive or Zip cartridge formatted appropriately for Mac or PC. Close the CD window and open 
the ZIP or the folder on the hard drive containing the collections.  
 
Open one of the collections by selecting Open from the File menu. Small boxes below the 
thumbnail images will have red Xs indicating that they are off line, which means that when you 
click on them no larger image will appear.  
 
Update the images in all the collections by opening each collection and selecting all the images 
by using the Select All command from the Edit Menu. (Tip: you can select all the images by 
holding down the Apple and A keys on a Mac simultaneously and deselect them by holding the 
Apple and 0 keys simultaneously).  
 
Next select the Update Location command in the Source File menu. Choose Specify disk or 
folder and click OK. Navigate to the CD, select the big_img file (click once), and click on the 
Select big_img button located near the bottom of the box. The machine will connect the 
thumbnails to their sources; the red Xs below each image will disappear and the large images will 
be connected. Thus the thumbnails on your ZIP drive will be connected to the large images on 
your CD. The large images will appear when you click on the thumbnail. Do this for all files before 
you begin to combine collections or create portfolios.  
 
COMBINING COLLECTIONS 
ImageAXS Pro allow you to have several collections open at a time and you will be able to drag 
images between open collections. To test this, open two collections by double clicking them. You 
may now drag images between collections. If a window called Cross-Collection Mapping 
appears, follow the directions under Creating New Collections.  
 
CREATING NEW COLLECTIONS 
If you want to create a new collection select New Collection from the File menu. Give it a name 
and drag images from other collections into it. A window called Cross-Collection Mapping will 
come up that will transfer the related information from one collection to the other. First click By 
Name, which will match all of the fields with the same names. Next move over the individual fields 
that were not matched. Use the following as a guide: 
 
 Artist     Field 1 
 Title    Field 2 
 Date    Field 3 
 Style    Field 4 
 Original Site   Field 5 
 Repository   Field 6 
 Copyright Holder  Field 7 
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Towards the bottom of list: 
 Acquire Date   Record Created 
 
When you are finished click OK.  
 
Check to see that your new field names have been added for your New Collection by choosing 
Field Names under Edit. If the information in the second column reads "Field 1, Field 2, etc." you 
will need to re-enter the correct field names. Simply use the guide above to name your fields. You 
may choose any thumbnail label you wish for your images by choosing from the list at the top of 
the page. When you are finished click OK.  
 
CREATING A PORTFOLIO.  
You can create many different Portfolios within any of your collections and then you can use them 
to organize your lectures.  
 
*Select the images that you want to use in your lecture portfolio and chose Open Selection As 
Portfolio from the Record menu and click the small Portfolio & pencil icon on the upper tool bar. 
Give your portfolio a name.  
 
You can add additional images to your portfolio by dragging them from any one of the collections. 
Be sure that both the window of the collection and the window of the portfolio are open; select the 
images you want to add and drag them to the portfolio window.  
 
You can  rearrange the images in your portfolio by dragging and dropping as you would on a 
light-table. Select the ones that you want to move and drag them up to the place you want them 
to appear. Release them into the  white triangle that will appear between the thumbnails . Images 
in Portfolios will remain in the order in which you have placed them. REMINDER: SEARCH AND 
MANIPULATE YOUR COLLECTIONS ON THE ZIP, NOT ON THE CD OR ELSE YOU WILL 
GET ERROR MESSAGES & CRASH THE PROGRAM!! 
 
ADDING ADDITIONAL IMAGES TO YOUR COLLECTION 
You can add additional images to your portfolio that are not on the CD. These may be images 
that you have scanned,  that  come from the web, or any other source. You can acquire them into 
the program in the same way you did the folder, except you chose Acquire File instead of 
acquire folder. I would suggest that you keep new images on your ZIP drive in a file called 
Images. Add the information in the appropriate Fields.  
 
Consult  the Help menu on the ImageAXS Pro program for further directions. Scansoft is currently 
supporting ImageAXS although they are no longer marketing it.  The help line is 408 395-8319. 
Site: http://www.scansoft.com/products/imageaxs/ 
 


